Working with Windows 7

Fastrack @wswn

» Operating System: An Operating System (OS) is system » Features of Windows 7: Following are some of the distinct
software that manages computer hardware, software features of Windows 7 that have made it the most popular
resources and provides commaon services for computer and commonly used operating system:

programs. It is the software that manages the overall > User-friendly GUI Interface and Multi-tasking:
working of a computer system and provides interaction Wikdows 7 has & iserdriendly GUI TnterFace that

between a user and the computer system. . L .
. ) ) . allows you to work with a pointing device, like a
» Windows 7: Windows operating system is one of the mouse. It even allows you to open and work with

most popular and commonly used GUI enabled operating R AR B e AR GRS e
system and Windows 7 is the version of Windows operating PP Bhas ’

system that is most commonly and widely used nowadays. > Aero Shake Feature: Windows 7 supports Aero
Windows 7 is a GUI based operating system developed Shake feature that enables you to click a window
by Microsoft. It has amazing features that have made it a pane and shake your mouse to minimise all other
popular cholce to be used at homes, offices, educational open windows. You can shake the pane again to
institutes and various other places. restore the windows to their original sizes.
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Aero Themes and Aero Background: Windows 7
allows you to use new themes or choose a slideshow
of your Favourite photographs to make your PC
reflect your personal taste.

Home Medla Streaming: Windowss 7 enables you to
use your PC as a hub to store and share the music,
videos, photos and even support TV Functions or
stream It to support other devices using the Play To
option.

Homegroup: The Homegroup Is a feature in
Windows 7 that enables you to easlly connect to two
or more PCs running on Windows 7, on your hame
network, for the purpose of sharing. You can share
plctures, music, videos, documents and printers
with other people in your hamegroup.

Internet and Digltal TV: You can watch the Internet
TV or turn your PC into a digital video recorder by
using the support In Windows Medla Center for
many new broadcast TV tuners.

Jump Lists: The Jump Lists feature allows you to
quickly access your Favourite, recent and frequently
used Files.

Improved Taskbar: In Windows 7, you can ‘pin’ your
fFavourite programs anywhere on the taskbar and
rearrange programs in any way you like by clicking
and dragging.

Aero Snap: This fFeature enables you to resize and
expand Windows more quickly. It also allows to
compare the contents of two different windows.
Aero Peek: This feature makes all the open windows
transparent, so that you can see the desktop.
Windows Search and Libraries: This feature enables
you to search the PC and the devices connected to
your network, to find items regardless of where
they are stored.

Windows Touch: Windows 7 Is compatlble with
touchscreen monitors. This Feature enables you to
interact with your PCwith a touchscreen monitor by
using your fingers and multi-touch gestures.

> Folders: Folders are the places where you can store
Files, Icons, directories, programs, data or other
folders (subfolders). Subfolders are also called

Subdirectaries.

» Taskbar: Taskbar is the long haorizontal bar that is
usually located at the bottom of the desktop screen.
It can be moved with the Start button on the left
and the clock on the right,

» Start Button: The Windows Start button s found at
the bottom left part of the taskbar. The Start button
opens the Start menu when we click on It. The Start
menu glves access to all the programs Installed an
the computer and also to other Windows features.

» Quick Launch lcons: The Quick launch icons let you
quickly launch any of the programs that are on the
taskbar.

» Pin a Program to Taskbar: You can pin or add
a program to the taskbar to quickly access that
program rather than going to the Start menu and
then accessing them.

> Notification Area: The Notification area is the area
of the taskbar where you can vlew programs and
tasks that are running In the background, as well
as view important messages about updating your
computer. It is also called the System tray.

» Clock: The default clock shows the date and time.

Gadgets: Windows 7 offers small application
programs called Gadgets to Facllitate your routine-
based tasks. Different types of gadgets such as
Calendar, Clock, CPU meter, Currency, Picture
Puzzle and Slide Show are there that can be placed
on the desktop.

> Sticky Notes: Sticky notes Is another useful feature
of Windows 7 and It can be placed on the desktop.
These are used for writing reminders ar for making
a To Do List.

» Show Desktop Button: The Show Desktop button is
located on the right end of the taskbar. Clicking this

> Baslc Components of a GUI Window: There are some button minimises all the opened program windovss
basic components that are part of each GUI enabled and reveals the Full desktop.
operating system. » Components of Window Screen: When you open an
> Desktop: When you turn on your computer system, application or a Ffolder, it is always opened within a
the first screen that you see on your computer rectangular frame structure known as Window. There
screen, after logging Is completed, is known as the are baslcally two types of windows. One Is an application
Desktop. It contalns all the applicatlon program program window that opens up when you open an
icons, Start button and Taskbar. application program such as WordPad. Another one is an
» lcons: lcons are small graphlcal Images on the explorer window that opens when you double-click on a
desktop that represent various applcation fFolder to view Its contents. The different elements are as
programs, files and folders. follows:
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» Title Bar: The Title bar appears at the top of the
program window. This bar displays the name of
the opened application program, folder and also
contains the Minimise, Maximise/Restore and Close
buttons.

» Scroll Bar: The Scroll bar appears when there is
more matter on the window screen to display.

» Address Bar: The Address bar allows you to
navigate up and down on a series of windows by
double-clicking an a folder.

> Navigation Pane: The Navigation pane provides
quick links to various folders and locations on the
computer.

» Tool Bar: The Tool bar contains the tools For
performing various tasks/functions.

» Details Pane: The Details pane gives the details
about the application or flle/folder which Is opened.
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» Menu Bar: The Menu bar has various menus such
as Flle, Edlt, Home, etc. Menus have a group of
commands that are used in an application program
to perform some basic Functions of Windows 7.

» Status Bar: The Status bar appears at the bottom of
the window and dlsplays the status of an application
such as edit, ready, etc.

» Rectangular Frame: The Rectangular frame is the
boundary of the window pane.

» Baslc Operations of a Mouse: The Mouse Is a pointing

device that is very useful while working on a GUI enabled
Interface. It Is used to move the cursor on the monltor

Fig. An Application Program Window (WordPad)
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screen to polnt at the Icons, to open Ffiles/folders/
applications and to perform many other tasks.

> Holding a Mouse: To hold the mouse, place your
thumb on the side of the mouse, your Index finger
on the left button and the middle finger on the right
button.

> Moving the Mouse Polnter/Cursor: Using your
right or left hand, pick up the mouse and put it on
the mouse pad. Once in position, drag the mouse
up, down, left or right to move the mouse pointer
on the screen.

» Clicking the Mouse: A mouse usually has two
buttons, /.e., Left and Right button except the scroll
wheel To click the left or right mouse button, simply
press the button and release It. This actlon Is called
clicking. A mouse supports the following three
types of click: Left-click, Right-click and Double-click.

» Opening a File or Program: Double-clicking opens an

application program, a file or a folder. Perfarm the below
mentioned steps to open an application program:

> Step 1: Move the mouse polnter to the program Icon.

» Step 2: Double-click on the icon to open it. It will
open in its software.

Selacting an Object and Highlighting Text: Selecting
objects or text is useful as after selection, operations such
as cut, copy and paste can be performed on the objects.
To select an object such as a file or a folder, move the
mouse to the object and click on It. For selecting multiple
objects, select any ane object, then press the Ctrl key on
the keyboard and click on other objects that you want to
select or highlight.
Drag and Drop: Drag and drop is used to move an item
present on the screen, to a new location. For example, to
move the Recycle Bin icon to a new location, perform the
below mentioned steps:
» Step 1:Single-click on the Recycle Bin icon.
> Step 2: Keep the left mouse button pressed and
move the mouse on the mouse pad. The selected
Recycle Bin icon moves along.
> Step 3:Selectanew location for the icon and release
the mouse button. The selected Recycle Bin Icon Is
at the new location.

b e e e e e e e e e e e e e e e e e e —— — — — —

Get More Learning Materials Here : &

@g www.studentbro.in



_ s m—e—e—-——————r——_—-—-r—_-r-:G—--_-Gr-:r-_-—-—|,:r-r-—rGr—-—:-—-r-—-rr-—-—-—r—-:—r-.-_,,-—-—----—-—--— "7

> Opening Context Menu: The Context menu, also known

as shortcut menu or pop-up menu, can be opened by right-
clicking the mouse button.

» Different Types of Tabs in Windows Operating System:

Tabs contaln commands that perform basic functions in
an application program. The following are same common
tabs that are available in almost all application programs
in Windows.
> File: It contains the options to work with files such
as creating a new fFile, saving a file, opening a file,
printing a file and import/export options.

» Home: It contains options such as cut, copy and
paste as well as other important editing lcons.
It sometimes contains specific options for the
program you are working on.

» View: It contains options that change the view
of items and also include some toolbar options.
Sometimes, we are unable to view some tools such
asaruler, navigation pane, etc. They can be activated
from the View menu.

> Insert: It contains the different insert Features such
as tables, pictures, Clip Art, WordArt, shapes and
much more.

» Shartcut: In Windows, a shortcut ican is actually a link

that polints to a program on the computer. It allows you
to create link of the required programs on any location
on the computer. A shortcut icon has a small arrow at the
bottom left corner of the Icon.

» Windows Accessories: There are a variety of small

applicatlon programs avallable In the Windows
environment. These small application programs are known
as Windows Accessories and are parts of the Accessories
folder. These bullt-n programs are useful far completing
everyday tasks.

To opean the Accessorlas folder, click on the
Start button — All Programs — Accessories.

» Paint: Palnt Is 3 part of the Accessarles folder. It Is used to

draw and colour simple drawings.

To open and start Paint, click on the Start button — All
Programs — Accessories — Paint to open Paint.

» Title Bar: It is the topmost bar of the Paint windows. It

contalns the name of the drawing.

» Quick Access Toolbar: It is located at the top of the Paint

window and contalns some Important optlons llke Save,
Undo and Redo.

» Menu Bar: The Menu bar s located under the title bar. The

first button on the left side Is the Paint tab which opens
the main menu of the Paint. In addition to this, there are
two more tabs—Home and View.
> Paint Tab: This tab allows you to open new or
existing Fles, save or print your work, acquire
images from scanner or camera, or you can send an
e-mail of your work.
» Home Tab: The Home tab contalns the tools for
editing and creating shapes, such as Brushes,
Shapes, Colors and many others.

> Vlew Tab: The View tab Is placed next to the Home
tab. Here, you can Zoom In/Out ar see an image in
Full screen mode.

Drawing Area: Drawing area is the area where you create
your drawings using different tools of Paint.

Calculator: The Calculator Is a utility program that allows
you to do mathematical and scientific calculations. It
works like a regular calculator.

WordPad: WordPad is a small word processor program
that is used to type the documents. It has features to let
you type the text as well as to Farmat the text.

Managing Files and Folders: Collection of Interrelated
information or data is known as a file. We save our work
in the form of files in a computer. There are different
types of Ffiles that can be created in a computer, for
example, document, plcture, audio, video, etc. Collection
of Interrelated fles Is known as a folder or directory. It
is like a container that can hold all the files, or a storage
drawer in which you can put your books, toys, etc. Files
and folders on a computer can be managed by a program
known as the Windows Explorar.

Restoring a File or a Foldar: It means to bring back
3 deleted file or folder again at its previous locatian.
Sometimes, we delete our file or Folder by mistake and
require to bring the data back. By using the restore
function, we can get our deleted Information back.

Shell Commands: The Shell Is an interface provided by
the operating system through which a user can Interact
with it. There are two types of user interfaces far an OS:
CUI (Character User Interface) and GUI (Graphical User
Interface). The CUI interface of Windows Is also known as
CLI (Command Line Interface). There are different shell
commands that you need to learn v/hile working with Files
and folders in CUl interface of Windows.
Different Shell Commands: The following are the
basic shell commands that are used to work with Files in
Windows CLI:
» dir (Directory): This command displays the list of
files and folders/subFfolders.
Syntax: dir
» cd (Change directory): This command changes the
directory locatlon.
Syntax: cd <dir/folder name>
» cd-: This command returns to the previous directory,
you were working in.
Syntax: cd-
» «d ..: This command moves you one directory up/
back in the directory structure.
Syntax: cd .. <dir/folder name>
» Is:This command lists the directory/folder contents.
Syntax: [s
» cls: This command clears the screen.
Syntax: cls
» del: This command deletes one or mare files.
Syntax: del <filename>
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» mv:This command Is used for either moving a file to
a new location ar For renaming the file.
Syntax: mv <old file name> <new filename>
mv <filename> <new location>
» Copy: This command copies one or more files.
Syntax: copy <file name> <new location>
» Control Buttons: The control buttons (Minimise,
Maximise/Restore and Close) are located at the right
corner of the title bar.
> The Close (X) Button: It closes an already open
window and thus allows you to exit a program.

» TheMaximise (O) Button: |t maximises the program,
making It Full screen. IF It Is already maximised, It
looks llke a box on the top of another box. If you
click on it in that state, it will return the window to
its previous size.

» The Minimise (-) Button: It reduces the current
window to a taskbar button. Clicking on the button
on the taskbar restores the window to its former
state.

Practice Exercise

(2] Multiple

(2] Fill in the Blanks

N Choice Questions

Q1. Which of the following keyboard shortcuts allows
you to nullify an action?
a CTRL+Z b. CTRL +B
c CTRL+Y d. CTRL+N
Q 2. Which of the following bars shows the status of an
application running in an application program?
a. Status bar b. Title bar
c Scroll bar d. Toolbar
Q 3. Which of the following buttons on a window allows
you to close it?
a. Start b. Minimise
c Close d. Show desktaop
Q 4. Which of the following Is a collection of files?
a Folder b. Document
c Holder d. None of these
Q 5. Which Windows folder stores the deleted files?
a Recycle bin b. System tools
C Accessories d. None of these
Q 6. Which of the following bars contains the tools for
performing various tasks/functions?
b. Title bar
c Scroll bar d. Toolbar
Q7. Which of the following tabs contains the options to
waork with files?
a. Flle b. Edit
C View d. None of these
Q 8. Which Windows folder contains the small application
programs such as Paint, Calculator, WordPad, etc?
a. Search box b. System tools
C Accessories d. None of these
Q9. Which of the following keys deletes a file/folder

a. Status bar

permanently?
a. Ctrl b. Shift
c Delete d. None of these

Q10. Which of the following buttons minimises an
application window?
a. Minimilse
c Close

b. Maximlse
d. Start

N Type Questions

QU. Windows 7 has a user-friendly .....cccumiicnne.
enabled user interface.

6 [ r-J00 & ¢ TS —" feature allows you to quickly
access your favourite, recent and frequently used
files.

Q13. The .....cceeusriessnennnn. fe@ture enables you to resize

and expand windows mare quickly and also allows
to compare the contents of two different windows.
2] T 5 ;T —— feature makes all your open
windows transparent.
Q15. The....ccccscsemeeenee..... @re containers that can contain
files, icons and programs.

Q16. The .......ccevnneeen..... button is found at the bottom
left part of the taskbar.

(7] Assertion and Reason

N Type Questions

Directions (Q. Nos. 17-21): In the questions given

below, there are two statements marked as Assertion

(A) and Reason (R). Read the statements and choose the

correct option.

a. Both Assertion (A) and Reason (R) are true and
Reason (R) is the correct explanation of Assertion (A).

b. Both Assertion (A) and Reason (R) are true. but
Reason (R) is not correct explanation of Assertion (A).

c. Assertion (A) is true. but Reason (R) is false.

d. Assertion (A) is false. but Reason (R) is true.

Q 17. Assertion (A): Windows operating system is one of

the most popular and commonly used CUI enabled
operating system and Windows 7 is the version of
Windows operating system that is most commonly
and widely used nowadays.
Reason (R): An Operating System (0S) is system
software that manages computer hardware,
software resources and provides commaon services
for computer programs.
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Q18. Assertion (A): Windows 7 enables you to use your
PC as a hub to store and share the music, videos,
photos and even support TV functions or stream it
to support other devices using the Play To option.
Reason (R): Windows 7 supports Aero Shake
feature that enables you to click a window pane
and shake your mouse to minimise all other open
windows.

Q19. Assertion (A): The Homegroup is a feature in
Windows 7 that enables you to easily connect to
two or more PCs running on Windows 7, on your
home network, for the purpose of sharing.

Reason (R): The Jump Lists feature allows you to
quickly access your favourite, recent and frequently
used files.

Q 20. Assertion (A): Aero Peek feature makes all the

open windows transparent, so that you can see the
desktop.
Reason (R): Aero Snap feature enables you to
reshape and expand Windows more quickly. It also
allows to compare the contents of two different
windows.

Q2L Assertion (A): Windows 7 is compatible with
touchscreen monitors. This feature enables you to
interact with your PC with a touchscreen monitor
by using your fingers and multi-touch gestures.
Reason (R): Icons are small graphical images on
the desktop that represent various application
programs, files and folders.

I Awncwiare |
| Answers |

1.(a) 2. (a) 3. (¢) 4. (a) 5. (3)
6. (d) 7. (a) 8. (¢ 9. (c) 10.(a)

L ]

11. GUI 12. Jump Usts
13. Aero snap 14. Aero peek
15. folders 16. Start

17.(d) 1B.(b) 19.(b) 20.(c) 21 (b)

2| Case Study Based

N Questions
Case Study 1

Windows 7 is a major release of the Windows
NT operating system developed by Microsofi.
It was released to manufacturing on July
22, 2009 and became generally available on
October 22, 20009. It is the successor to Windows
Vista, rcleased nearly three years earlier. It
remained an operating system for use on personal
compulers, including home and business
desktops, laptops, tablet PCs and media centre
PCs, and itself was replaced in November 2012
by Windows 8, the name spanning more than
three years of the product.

b d

Until April 9, 2013, Windows 7 RTM provided
content such as security updates, software
updates, PC driver updates and technical support,
after which installation of services Pack | is
required for users (o receive support and updates.
Windows 7's server counterpart, Windows Server
2008 R2, was released at the same time.

QL Windows 7 is an Operating System launched by

Microsoft in:
a. 2006 b. 2009
c. 2007 d. 2008
Q2. Windows 7 Operating System is an upgrade
from:
a. Window 98 b. Window 2000

c. Window Millennium d. Window XP or Vista

Q3. Windows 7 new Aero Interface Features

includes except:
a. Aero Peek b. Aero Shake
c. Aero task d. Aero Snap

Q4. Moving an item across the screen with the

mouse.
a. Web browser b. Double-clck
c. Drag d. Recycle bin

{ Answers }

&

| Wit
1. (b) 2. (d) 3. () 4. (c)

Case Study 2

QL
Q2.
Q3.

Q4.

Windows 7 is a GUI based operating syslem
developed by Microsoft. It has amazing features
that have made it a popular choice to be used at
homes, offices, educational institutes and various
other places. It has a user-friendly interface that
is very convenient to use and even a person who
is not well versed with computers can learn and
use it easily. The user need not type commands
like in the CUI operating system.

What do you mean by the term client?

Define Library in window 7.

Name the programs designed to make users more
productive.

Define Aero glass.

Mrcieare 1
Answers

Wl ot i

. Computer connected to a server is called Client.

. A library Is a collection of falders and files that are
stored In several locatlons across your computer or
netwarkc

. Application Softvare are the programs designed to
make users mare praductive.

. Translucent glass effect around the borders af the
windows Is known as Aero glass.
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(2] Very Short Answer

QL
Ans.

Q2.

Ans.

Q3.

Ans.

Q4.

Ans.

Q5.

Ans.

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

| Q6.
Ans.

Y

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

|

Ans.

Q8.

Ans.
Q9.
Ans.

Q1lo.
Ans.

QlL
Ans.

Ql2.

Ans.
Qla.

Ans.

N Type Questions

What do you understand by Windows?

Windows is an operating system that controls
all parts of that computer system on which it Is
installed.

What do you mean by lcons?

Icons (or graphical pictures) represent applications.
files and other parts of the operating system. These
are the maln part of GUI which help a user to operate
some digltal device In an easy way.

Explain taskbar.

Taskbar Is the long horizontal bar at the bottomn of
your screen. It includes Start button, Quick Launch
toolbar, Open Application toolbar, Notification area
and Show Desktop button.

Where is the title bar located?

The title bar Is the horizontal bar located at the top
of a window. It displays the name of the windows or
software program belng used.

Define the Maximise button.

The Maximise button in Windovss is the middle
button with square. It allows the user to enlarge a
window. usually making It fills the entire screen.
Name any three Windows accessories.

Notepad. Paint. Calculator.

How do you start the Paint in your computer?
To start the paint:
Click Start — All Programs — Accessories — Paint

What is the use of Navigation Pane in folder
window?

Navigation Pane offers to access Ubraries, folders,
saved searches and even the entire hard disk pane.
contents. etc.

For what purpose, left clicking is often used?

Left clicking Is most often used to select or open a
file/folder.

What is a Folder?

A folder s a location or storage space where
programs, files and other folders can be located.
Explain Documents folder.

Documents is a folder that stores user's important
files and folders that are used with many of the
Programs running on your computer.

Yesterday, Rahul created a file named detail.txt
and saved it. Now, he wants to open it but he has
forgotten where he saved it on his laptop. Suggest
him a way to find the file.

He can find his file by using Search option.

Name the next version of Microsoft Windows after
Vista and XP.
Windaows 7

Q 14.
Ans.

Q1.
Ans.

Name the feature avallable in Windows 7 ultimate
for data security.

Bit Locker Data Protection Is the feature avallable In
Windows 7 ultimate for data securlity.

What does the WYSIWYG means?

WYSIWYG means that a printed document s exactly
a copy of what you see on screen.

(2] Short Answer

\[Tgpe Questions

Q1. What does Aero Shake feature of Windows 7

Ans.

Q2.

Ans.

Q3.
Ans.

Q4.
Ans.

Q5.

Ans.

Q6.

Q7.

Ans.

Q8.
Ans.

enable you to do?
Windows 7 supports Aero Shake feature that
enables us ta click a window pane and shake our

mouse to minimise all other open windows. We
can shake the pane again to restore the windows to
thelr original slzes.

What are Gadgets?

Windows 7 offers small application programs
called Gadgets to facilitate our routine-based tasks.
Different types of gadgets such as Calendar, Clock.

CPU meter. Currency. Feed Headlnes. Windows.

Media Center. Weather. Picture Puzzle and Slide

Show are there that can be placed on the desktap.
Discuss the purpose of the Scroll bar.
The Scroll bar appears when there is more matter

on the window screen to display. This Is usually a
vertlcal scroll bar, but a horlzantal scroll bar may
also appear if the width of the window is too narrow
and the information is too much.

How does a context menu open up?

Clicking on the right mouse button apens up a menu

called the context menu that has various commands
related to an application program.

Start menu is a gateway to the applications.

Describe it.
The Start menu is a gateway to the applications that

are present on your computer. The left side of the
Start menu Usts programs and the right slde allows
access to common windows folders. It also provides
access to Help and Support. Search and Run options.
What is the significance of icons? Give the example
of any three types of icons.

. lcons refer to pgraphic symbols that represent

window elements. The three types of Icons are as
follows: the application icon, the shortcut lcon and
the document Icon.

List some main companents of a default window.

The main components of a default window are as
follows:

(i) Title bar (ii) Scroll bar

(iif) Menu bar (iv) Status bar
Discuss the features of Title bar.

Title bar displays the name of the window or

software program. This bar can maximise, minimise,
restore ar close a window. It Is also used to move a
window using any pointing device.
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Q9. Suppose you move or copy a folder named
Alignment. The Alignment folder contains four
subfolders, namely Left, Center, Right and Justify.
When the folder is moved/copied to another
location, will it carry with its the four subfolders
Left, Center, Right and Justify or not?

Ans. Yes, the Alignment folder will carry the four
sub-folders Left, Center, Right and Justify because
vshen we move or copy a folder to a new location.
then all its contents (i.e. sub folders and files) also
get moved or copled.

Q10. GUI has become a standard way of how to users
interact with a computer? Its one feature is
WYSIWYG.

() Give full form of both abbreviations used in the
above paragraph.
(il) Write one other feature of GUI.
Ans. (i) GUI - Graphical User Interface
WYSIWYG - What You See s What You Get

(i) GUI contains icons that represent files. folders
and other applications.

Q 11. Sweety wants to use an operating system based
on graphical user interface, suggest her a name.
Also, tell what is the meaning of graphical user
interface?

Ans. Windows is an operating system based on graphical
user interface. Graphical user interface means that it
has pictures (graphics) that you use to communicate
(interface) veith the computer.

Q 12. Rajat is a commerce student and wants to do his
homework but somehow he has lost his calculator
and wants to take computer’s help. He has Windows
7 on his system. Suggest him a way to do so.

Ans. Rajat can use calculator In the system that can do
simple as well as sophisticated calculations.

To start the calculator:
Click Start — All Programs — Accessories — Calculator.

CHAPTER TEST

Multiple Choice Questions

QL Which of the following
combination to cut a file?
a. Ctrl +C b. Ctrl + Vv
c Ctrl + K d. Ctrl+ X

Q 2. Which of the following shortcut key combinations
allows you to delete a file permanently?
a. Shift + DEL b. CTRL + DEL
c Ctrl+ X d Curl+ K

Q 3. Which of the following bars shows the name of an
opened application program?
a. Status bar b. Title bar
c Scroll bar d. Address bar

Q 4. Which of the following bars allows you to navigate
up and down a serles of windows by double-clicking
on a folder?
a. Status bar b. Title bar
c Scroll bar d. Address bar

Q5. Which of the following buttons minimises all the
running program windows and reveals the desktop?

Is the shortcut key

a. Start b. Minimise
c Close d. Show desktop
Fill in the Blanks
Q6. ThE .coeerreeenereeeeeereeseaseenneoe. button Is found at the

bottom left part of the taskbar.

Q7. Collection of interrelated information or data is
KNOWN @5 @ cooveiriiienisessessssssssnnnnsnnn s

Assertion-Reason Type Questions

Directions (Q. Nos. 8-9): In the questions given below,
there are two statements marked as Assertion (A) and
Reason (R). Read the statements and choose the correct
option.

a. Both Assertion (A) and Reason (R) are true and
Reason (R) ks the carrect explanation of Assertion (A).

b. Both Assertion (A) and Reason (R) are true. but
Reason (R) Is not correct explanation of Assertion (A).

c. Assertlon (A) Is true. but Reason (R) Is false.

d. Assertion (A) Is false, but Reason (R) is true.

Q 8. Assertion (A): WordPad is a small word processor
program that is used to type the documents. it
has features to let you type the text as well as to
format the text.

Reason (R): Quick Access Toolbar is located at
the top of the Paint window and contains some
Important options like Save, Undo and Redo.

Q9. Assertion (A): The Status bar appears at the top of
the program window. This bar displays the name
of the opened application program, folder and
also contains the Minimise, Maximise/Restare and
Close buttons.

Reason (R): The Tool bar contains the tools for
performing various tasks/functions.

Case Study Based Questions

Q10. Windows 7 was intended to be an incremental
upgrade 1o Microsoft Windows, addressing
Windows Vista's poor critical reception while
maintaining hardware and software compatibility.
Windows 7 continued improvements on Windows
Acro (the user interface introduced in Windows
Vista) with the additon of a redesigned taskbar
that allows applications to be "pinned” to it and
new window management features. Other new
features were added to the operating system,
including libraries, the new file-sharing system
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HomeGroup and support for multi-touch input.
A new "Action Centre" interface was also added
to provide an overview of system security and
maintenance information and tweaks were made
to the User Account Control system to make it
less intrusive. Windows 7 also shipped with
updated versions of several stock applications,
including Internet Explorer 8, Windows Media
Player and Windows Media Centre.

(i) What action allows you to open user account
and makes the computer available?

a. Passwaord b. Start menu

C. User interface d. Logging on
(ii) Move the mouse pointer to rest on the item of
choice.

a. lcon
b. Web browser
C. Programme Presentation

d. Point

(iii) When you press and release the primary mouse
button is called:

a. Clck
b. Double-click
c. Programme presentation

d. Website.
(iv) Collection of gadgets is:

a. Microsoft window  b. Gadget gallery

c. User name d. Recycle bin

Qll. Windows is a graphical operating system

developed by Microsoft. It allows users to view
and store files, run the software, play games,
watch videos and provides a way to connect to the
internet. It was released for both home computing
and professional works. Microsoft introduced
the first version as 1.0. It was released for both
home computing and professional functions of
Windows on November 10, 1983. Later, it was
released on many versions of Windows as well
as the current version, Windows 10. Microsoft
Windows includes a wide array of features,
tools and applications to help get the most out of
Windows and your computer.

(i) What do you mean by the term sticky notes?
(ii) Define Aero snap feature in windows operating

system.
(iii) Define Aero peek feature.
(iv) What is mean by Drag and Drop?

Very Short Answer Type Questions

Q 12. Define Notification area.
Q 13. What is the use of address bar?

Short Answer Type Questions

Q 14. What is a Restore button?
Q 15. What is the use of double click? @

L
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